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Review of ORIOLE:  current capabilities 

Summary 

A question was raised regarding system capabilities.  The areas of interest were Session Closures and 

Theatre Case Cancellations.  The next section of this document describes and shows samples of the 

existing quarterly activity reporting, that was produced by dint of much manual effort.   

This issue is this: does Oriole have the capabilities within it today to generate the required analytics? 

It’s clear from the results described below, that the ORIOLE system for Operating Theatres 

Intelligence does indeed have the current capability to produce the required information. 

Methodology 

 First, for each of Theatre Cases and for Session Closures, an analysis was done of whether 

the basic information was actually present in the data warehouse (the cube).  All required 

information was indeed present within the data warehouse, and very easily accessible using 

point, click, drag-and-drop of the appropriate selections in the Cube Browser.  Please note 

that the Cube Browser is in SQL Server Management Studio, which is an Informatics tool. 

 Second, existing canned reporting was looked at to see if it would produce the information 

required.  It was determined that it would not produce the specific analytics required. 

 This lack of canned reporting capability was considered quite acceptable.  The canned 

reporting was only ever intended to cover 80% of known initial requirements.   Ad-hoc and 

new reporting had always been intended to be produced in the first instance using Excel, as 

is demonstrated in this document.  Excel is the way to cater for the unanticipated 20%. 

o Should the new report be a one-off, then it would be produced in Excel (with or 

without the use of PowerPivot as appropriate). 

o Should the new report be a regular requirement, then it would be produced in Excel 

(with or without the use of PowerPivot as appropriate).  Afterwards, it would be 

added to Excel Services or the PowerPivot Gallery as appropriate, so that anyone 

may run the new report on-demand. 

o Should monitoring of the new Excel report indicate that it was being run very 

frequently, and consuming a lot of resources, then it should be re-written as a 

canned report and added to the standard report library.   

 Finally, Excel was used as a simple reporting tool, again using point, click, drag-and-drop of 

the appropriate selections.  This method required nothing more specialised than Excel on 

the desktop, which is indeed an end-user tool, and which was intended to be available to 

everyone.   The later sections of this document give very detailed step-by-step instructions. 

 It is important to have the right desktop tool, which is the current version of Excel (i.e. Excel 

2010).  Once you have that, the entire data warehouse is open to you.   

It’s also necessary to have a reasonably up-to-date version of Internet Explorer to be able to 

use the canned reporting properly (i.e. at least IE8).  
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Quarterly Activity Reporting Requirement 

Theatre Case Cancellation 

 

 

 

The requirement is to be able to count Theatre Case Calculations by reason for cancellation, and to 

drill into the underlying data to find the specific reasons for cancellation. 

The need at this time is to demonstrate that this can be done using the common or garden desktop 

analytics tool, Excel. 

 

Note that canned reports can be exported in Microsoft Word format, or simply pushed directly to 

Subscribers on a periodic basis,   

Given this requirement is quarterly, Redwing recommends a canned report..   



Queen Elizabeth Hospital Oriole capability review 12 February 2018 
 

Redwing © 2014  Commercial Confidential Page 5 of 24 

 

Session Closure Requirement 

 

  

 

 

 

The requirement is to be able to count Session Closures by reason for closure, and to drill into the 

underlying data to find the specific reasons for closures. 

The need at this time is to demonstrate that this can be done using the common or garden desktop 

analytics tool, Excel. 

 

Note that canned reports can be exported in Microsoft Word format, or simply pushed directly to 

Subscribers on a periodic basis,   

Given this requirement is quarterly, Redwing recommends a canned report.    



Queen Elizabeth Hospital Oriole capability review 12 February 2018 
 

Redwing © 2014  Commercial Confidential Page 6 of 24 

Analysis of Theatre Cases 

Measures (the things we can add up) that are available for analysis of Theatre Cases.   

The ones circled in  red  are the ones of interest.   Cancelled Within A Day is the Case Count for 

Theatre Cases where the time of cancellation is with 24 hours of the projected operation date and 

time. 

The dimension attributes in green are also of interest. 
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This is how Cancellation information looks in the data warehouse (cube) browser.  Note that one cell 

has been picked.  It is highlighted.  When the right mouse button is clicked, the pop-up contextual 

menu appears.  The choice being made in this example is to list the underlying data. 

 

When List Cancellation text is picked, this drillthrough pop-up appears, showing the detail supporting 

the number 8 in the cross-tab table in the browser: 

 

Both the numbers and the underlying data are available for reporting.  Of course, the text must be 

entered into ORMIS in the first place.  It will not be available for any reporting otherwise. 

The conclusion from all this is that the ORIOLE data warehouse does indeed contain all the 

information on Theatre Case Cancellations that could be required for any analysis, assuming it had 

been entered in the first place.  Of course, if not, then not even going back to ORMIS will help. 
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Analysis of Sessions 

Measures (the things we can add up) that are available for analysis of sessions.   

The ones circled in  red  are the ones of interest. 

 



Queen Elizabeth Hospital Oriole capability review 12 February 2018 
 

Redwing © 2014  Commercial Confidential Page 9 of 24 

Measures of interest 

Session Count Raw count of sessions 

Single Double Count of sessions where half day sessions count as 1, 
an all-day session counts as 2.  Single Double is 
always bigger than Session Count. 

Unfunded Sessions ‘Single Double’ where there is no funding 

Funded Sessions ‘Single Double’ where there is funding 

Planned Closures The amount by which Funded Sessions is to be 
reduced for reasons such as Audit or Consultant 
Surgeon Annual Leave 

Planned Sessions Funded Sessions minus Planned Closures 

Unplanned Closures The amount by which Planned Sessions is to be 
reduced for reasons such as No Beds Available or 
Equipment Failure 

Open Sessions Planned Sessions minus Unplanned Closures 

Here’s a diagram showing an example of these calculations: 

Closed
Planned
Funded

Closed
Unplanned

Funded

Open

Funded

Unfunded

Funded 
Sessions

( B )
58

All 
Sessions 

( A )
60

also 
known as 
Possible 
Sessions

Planned 
Sessions 

( C )
54

Planned 
Closures

4

Open 
Sessions

( D )
49

Session Type Breakdown and KPI Calculation
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List of all possible Session  Closure and Reinstatement Codes that could be used 
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Browsing the Data Warehouse (Cube)   

Using a test database of realistic but not real data, the following results were obtained with the Cube 

Browser.  This is for a single month, but could be any time period desired.: 

Result 1.  The measures alone. 

 

 

 

This makes perfect sense.  Everything is in order: 

Session Count 456 

Single Double 515  

Unfunded Sessions 6 

Funded Sessions 509 ( = 515 – 6 ) 

Planned Closures 13 

Planned Sessions 496 ( = 509 – 13 ) 

Unplanned Closures 29 

Open Sessions 467 ( = 496 – 29) 

 

 

Result 2.  Broken down by reinstatements. 

 

 

 

Reinstatement statistics are useful to know, but the salient point here is that Reinstated Sessions fall 

into the Open Sessions category. 
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Result 3.  Broken down by Closure Group and specific Closure Type. 

 

 

Note that empty rows are not shown, so this month, the test data did not have any Theatre 

Washdowns, for example.  Open sessions are included, and show up in the Grand Totals. 

The next image shows Open sessions filtered out  and with empty rows present. 

Here’s what it looks like.  Note that the numbers and totals remain the same: 

 

In July, we had a raw count of 30 sessions closed. 

 

Result 4.  Theatre Closure KPIs. 

We can, of course, generate all possible KPIs around closures. 
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Getting the most detailed level of data (the atomic transactions) 

 

As before, we could right-click and get a popup.   

If we did that, here’s the data view (split over two lines): 

 

 

 

 

However, we can also list the raw data directly (all lowest-level data is in the cube).  This is for July: 

 

Note 30 rows; this is consistent with the totals shown in the cube browser 

Note Session Type.  Some sessions are identified as Unknown.  This is how the data was originally 

entered into ORMIS. 

Note also the comment column in the middle.  There is a place for text to be entered describing the 

reason for Session Closure.   If it is not entered into ORMIS, it is not available for analysis. 

 

The conclusion from all this is that the ORIOLE data warehouse does indeed contain all the 

information on Session Closures that could be required for any analysis, assuming it had been 

entered in the first place.  Of course, if not, then not even going back to ORMIS will help. 
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Reporting: connecting to the data warehouse 
 

Starting with a blank Excel 2010 worksheet 

 

 

 

 

 

Select the Data tab and highlight ‘From Analysis Services’ from the ‘Get External Data’ section 
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A dialog box appears.  Complete the server name, allow the default ‘Use Windows Authentication’ 

and click ‘next’ 

 

 

 

And another dialog box appears 
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This is interesting.  The last column says Type, and under it, is PERSPECTIVE and CUBE.   

CUBE is the entire data warehouse.  Don’t use that one, it is too complex, and we want separate 

reporting for Sessions and Theatre Cases.  Each PERSPECTIVE is a subset of the warehouse, showing 

just the relevant parts.   

 

At this time, make sure that Oriole appears in the drop-down list box labelled ‘Select the database 

that contains the data you want’, highlight Sessions, tick the check box labelled ‘Connect to a specific 

cube or table’ and then click Next.  (Note that the Oriole database contains the CUBE and the 

PERSPECTIVEs.) 

 

This should bring up the Data Connection Wizard. 

 

 

 

 

As you can see, we’ve labelled it ‘Oriole Sessions’ and this is the last step in connecting to the data 

warehouse. 

Click ‘Finish. 
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Later, you can repeat these steps, but choose the Cases perspective, to create a data connection to 

the Theatre Cases perspective in the cube. 

With the Data connection established, we’re now going to Import Data. 

After the finish button was clicked, you will get a dialog box like this: 

 

 

 

The default is good here.  Click OK to create a PivotTable report.  We’re not going to create any 

charts, or do more fancy stuff with PowerPivot and the DAX Data Expressions language.  This is going 

to be quite basic.   Bells and whistles can be added later. 
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This is a basic Excel spreadsheet.  It is connected directly to the Sessions Perspective of the data 

warehouse, and has access to all of the data we looked at in Analysis of Sessions. 

 

 

There are three things to note here: 

 The PivotTable File List pane on the right of the main window; 

 The three highlighted buttons for controlling what you see and what you don’t; and  

 The PivotTable tools tab at the top of the Ribbon.  In the image above, the Options tab is 

selected.  The image below show the Design tab. 
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Reporting: develop a spreadsheet.   
 

If you have never worked with PivotTables before, then here’s a good general guide.   

Here is a useful webcast (SQL Server 2008 R2 Analysis Services: Creating Excel 2010 PivotTable and 

Developing Report with Analysis Services Cube. 

 

Please note that clicking a cell outside the chart or table area removes the field list from view. 

 

The first step is to pick the fields to add to the report in the PivotTable Field List. 

Pick Session Count, and the spreadsheet will change to this: 

 

  

Note that the Session Count is checked, and it appears in the Values section at the lower right. 

  

http://www.howtogeek.com/howto/13336/working-with-pivottables-in-excel/
http://www.ditii.com/2011/03/28/webcast-sql-server-2008-r2-analysis-services-creating-excel-2010-pivottable-and-developing-report-with-analysis-services-cube/
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Time to add a date filter.   

1. Scroll down the Field List until you get to Calendar.   

2. Drag Y-M-D to Report Filter.  You will note a check mark appear, and there will be a Y-M-D in 

cell A1.  It will say All in B1, and there will be a down arrow.  

3. Click on the down arrow.  You will get a selection pop-up. 

4. Put a tick in the ‘Select multiple items box’, then click on the + sign next to the word All. 

5. The years will appear.  Remove the tick from the box next to All. 

6. Click the + next to Calendar 2011.n  The months of 2011 should appear. Put ticks next to 

July, August, and September. 

The screen should look like this: 

 

 

 

You’ve just done a Report Filter multi-select, picking out the three months. 

Of course, you don’t have to pick the same three months.  It depends on what you are interested in. 

 

Don’t forget to click OK at the end!  The screen should now look something like the image below.  

Note the filter icons in the PivotTable Field List. 
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Now, drag Y-M-D into the Column Labels section. 

 

 

It has disappeared from A1 and B1, and re-appeared as a filtered (note the icon in B3) set of column 

labels.  Open up the labels by pressing the + in B4. 

 

 

If you look on page 7 under Browsing the Data Warehouse, you will see a value of 456 for July’s 

Session Count.  It’s the same 456 as in B6.  That’s because it is the same data.  Not a copy of that 

data.  This is reading the data warehouse directly, just like the Cube Browser. 

It’s the real thing. 
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Now, drag Closure Group and then Closure Desc from under Closure Type to Row Labels.  Your 

screen should look like this: 

 

 

Almost there. 

We are now going to change the Row Labels to add a multi-select filter.  We’re going to lose the 

Open Sessions. 

 

 

Note that B3 has a down a down arrow plus a filter icon. 

Note that A5 has just a down arrow. 

 

Click on the down arrow in A5, where it says Row Labels.  You get a selection pop-up and the first 

thing It says is Select Field.  Click on it, and you will see that it offers the options of with Closure 

Group or Closure Desc.  Leave it at Closure Group.  

In the lower section, remove the tick from the box next to Open.. 

Click OK, and you screen should look like this: 
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And there it is.   

A few cosmetic changes and it’s just like it appeared in the Cube Browser that’s built into SQL Server. 
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Here is Theatre Case Cancellations: 

 

 

Again, the numbers are good. 

And again, we can click on a specific cell for more detail.  This is called drillthrough. 

 

 

  

And the raw atomic data: 

 

 

This demonstrates that everything we could do by interrogating the data warehouse directly using 

the tools in SQL Server, we can also do using Excel 2010 on the desktop. 

Column Labels

Calendar 2011

Calendar 

2011 Case 

Count

Calendar 

2011 

Cancelled 

July 2011 August 2011 September 2011

Row Labels

Case Count Cancelled 

Within A Day

Case Count Cancelled 

Within A Day

Case Count Cancelled 

Within A Day

Bed Shortage 8 8 94 94 73 73 175 175

ICU/HDU Bed Shortage 3 3 8 8 5 5 16 16

Ward Bed Shortage 5 5 86 86 68 68 159 159

Clinical 115 79 53 39 105 63 273 181

Operation not Required 85 52 28 20 75 37 188 109

Patient Unfit 30 27 25 19 30 26 85 72

D.N.A. 6 6 6 6 8 8 20 20

Did Not Arrive 6 6 6 6 8 8 20 20

Equipment 1 1 1 1

Failure/Unavailable 1 1 1 1

Non-Clinical 121 63 105 58 59 27 285 148

List Overrun 8 8 3 3 6 6 17 17

No Surgeon/Anaesthetist 4 4 29 21 6 3 39 28

No Theatre Staff 5 5 3 3 8 8

Other 19 14 8 7 8 5 35 26

Patient Cancelled/Refused Operation 85 32 62 24 39 13 186 69

Grand Total 251 157 258 197 245 171 754 525


